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+ QUICK REFERENCE CARD -

Note: In the lite version, you can not add authors, groups, or additional scaffolds. You should use the Basic or Enhanced version to set-up
your database and then your users can use the lite version to add their ideas to the database.

SIGNING ON
To log into Knowledge Forum: lite version:

1. Type your Knowledge Forum URL address in your browser in the format:
http://yourmachinename :port#/kforum
The “Welcome to Knowledge Forum” window appears
along with a KnowledgeForum.jnpl downloaded to your computer.
For your next log-in, you can either type URL address in your
browser again or double-click the KnowledgeForum.jnpl. — = 5

. Select a language from the Language drop-down list. T I ]
. Select a database from the Databases drop-down list. Password:
. Type your username in the Login field.

i English )

( Cancel ) - Login

g~ W N

. Type your password in the Password field.
6. Click Login. —

KnowledgeForum.jnip

Knowledge Forum opens to a view.

View: Sciegee: Flight of Airplanes

[EJ5cience: Teacher Discussion
[Jan 21,2002-Oct 7, 2002]

@x-12 igs

[an 22, 2002°) 2004]
(&3 Wekcome To Knowledg®

[Jan 18,2002-5ep 12,2007]

View Link

Double click to go
to view. bapefthewing Hrd to explain View Headings
ichard R. TeT. . .

Toolbar 2 nghhght and

See below. oo™ organize selected
’ : objects.

Note W

Double click to Wore info )

read note. ary W Experiment 2

Movie
Double click
to open.

Attachment
Double click

[Wind is a factor
Bereiter C.
@ About flightmoy

Higher means lower pressure
[ About airplane construction EReCE L

0 of 21 selected. .

o 1 [ wiLinks

to open.
Info Links Shows build-on or
About the view. reference links.
THE TOOLBAR Although the
New Note ﬁ View Finder toolbar appears
To create a new note To find or create a view on every view,
Search . Workspace srﬁmri 22?‘;23
To search the database =4 288 To access your Workspace 9
available to you
Assessment Tools ul Show/Hide Palette depending on
Available if tools have been added To show or hide the drawing palette your user type.
Help m Logout
To get online help 3 To exit Knowledge Forum
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CREATING A NOTE

1. Click - The New Note window appears. 3. In the File menu, select Save. You will be
2. Complete the basic note features. You do not need prompted for a title for the note and you can
to use every feature when creating a note. The select the view in which this note will appear.
basic note features consist of the note contents, The note icon will be added to the view and the note
problem, scaffolds, and keywords. window will remain open.
Click to access Shows authors and allows Shows connections to Type the
pull-down menus. you to add co-authors. other notes and views. problem.
.. Knowledge Foru (le Edit Style Objecty” Publish Windo
ﬁ sl New Note - Marge A

4 Zz
Mote | Aut‘lars Cannecti0£ Info Histary ]
Add scaffold { ' /}m/

supports: | __» BheoryBuiding | Problem e Type

e Selecta M = | content.
y theory
scaffold from ¢ Arrange

EI need to understand

the Scaffolds movies,

drop-down Iist./g"‘"/"""f""“m"“ attachments,

« Select a/ This theory cannot explain < “.otes, and
scaffold (:A better theory = \c/;ews .by
support by (( Putting our knowledge togethe a:%gg'ng
double-clicking

dropping.
the support, or| = = = - pping
click the " e ) Keywords

Add button. - - - - <
uren \id 1 | Insert Drawing | Build-on [ AnnntQ\J | Close |
1 A == Z

Use keywAl to Ty;n keywords.

select keywords in
note contents.

Click to insert After the note has Click to create
drawing in note. been saved this will an annotation.
highlight. Click to
create a build-on note.

ATTACHMENTS AND MOVIES

To add movies and attachments (other documents or images) is to drag them from your desktop to a
Knowledge Forum view or note. An image (jpg, png, or gif) can be displayed as an image by using the
Objects pull-down list on the note or view and selecting Show in Place.
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CONNECTING IDEAS

Referencing

A Whole Note

Drag and drop the note icon to reference into the content of the referencing note.

A Part of a Note (Quoting)

Open the referenced note and copy the text you wish to quote, then paste into the content of the
referencing note.

A View

Drag and drop the view icon to reference into the content of the referencing note.

A Web Page

Type the Web link in http:// format in the content of the note.

Build-On

Open a saved note and click the | Build-on | button on the bottom of the note. shape of the wing

hard R.

A build-on note will open. Add your ideas. When you save the build-on note,
it will be connected to the note it was built on.

Owval shaped
Co-Authors Hector H.
If you are an author of a note, click the - Authers | tab on the top of the note. Add or remove authors to
this note.
Annotate

) O Annotation
Open a saved note and click the 1 Annotate l button on the bottom of the note. % —

An Annotation window will open. Type in your annotation. When you close and

save it an Annotation icon followed by the name of the author will appear in
the note. y

Rise-Above

From a view, select the notes you want to rise above (including notes from other users) and select
Rise-Above from the Objects pull-down list. A rise-above folder g will appear in the note containing the
notes that were selected. Complete the creation of the new Rise-Above note.

WORKSPACE

Your Workspace is a private space where you can create and edit notes, work on a drawings, add
attachments or movies that are only accessible by you. When you are done working on your ideas, you can
add them to a view to make them accessible to the community by dragging and dropping them from your
workspace to a view.

The Palette button shows and hides the drawing palette. Use this
palette to create a drawing in a view or a note.

You can also drag and drop a jpg, png, or gif from your desktop to a I h || T || d || / || - || - |

view or note, then use the Object pull-down list to Show in Place.
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r_ THE VIEW FINDER

) : & .’ Knowledge Forum File Edit Objects Layout Windows
to access the View Finder. @0 o View Finder )

-| 1. From a view, click

2. Type in the name of the view you want to find or —
Sortby: () Title @ Date Modified () Date Created () Authors

click

3. Drag and drop from the View Finder to a view to
create a view link.

Creating a New View

1. In the View Finder, go to the File pull-down list and select New View.

CREATING A VIEW LINK

To create a view link in a view:

* Drag a view icon from the View Finder to a view or from a view to a note.

SEARCH

Search for objects by words, author, title, keyword, date modified or date created.
To perform a search:

1. Check or uncheck the Notes, Views, '8.6 BKnowleclge Forum File Edit Se(zhj:l:ts Layout Windows -
Attachments, Movies and Drawings £
check boxes to indicate the Search for: [ Notes [ Views [ Attachments [ Movies [_] Drawings
Knowledge Forum objects to search for. ; .
9 ! (Title F:]‘ contains | | E
2. Select the criterion from the Search
drOp-dOWn ||St Sort by: O Title 8 Date Modified O Date Created O Authors
3. Type the search term in the text field.
4. Click Search.
( Previous ) [ Next
SRR S A
o )
—
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To log on to Knowledge Forum:

SIGNING ON

1. Type your Knowledge Forum URL address in http://yourmachinename:port#/
Ve come |2 <naai=dne orum format in your browser. The “Welcome to Knowledge Forum” window appears.
B 2. Select a language from the Language drop-down list.
Lo vy (DT TR .
rewein EEEETTEEE 3. Select a database from the Database drop-down list.
Ul ¥aas ICNFTENS 4. Choose the Ul Mode, Enhanced, to match this Quick Reference section.
5. Type your username in the Username field.
6. Type your password in the Password field.

] ; ;
— 7. Click Sign On.

e L Knowledge Forum opens to a view.
[N

ks o mmrare

Fir aprosmsi

View: Science: Flight of Agplanes ]

File Edit Objectsylp View Layout Windows

cdit || delete || > delete || 4

Menu options [0 prablem: hy do Aplanes Py

Richard R. [Dec 2, 1999-Oct 007I
View Link 5
Double click to go ||
to the view.

:\' xhzh:e':ﬂlxha wing.
Toolbar\_l N
See below. i
Note— | %

Double click to
read the note.

— View Title

View Headings

lick to edit title.
Drag and drop
objects to add
to heading,

Attachment: Image
Shown in place.

Movie——— ||~
Double click

2 About flightmov.

to open. P D He i :
Attachment 51s| wiinks | Oof 21 selected.
Double click \
to open. Info Links Shows build-on or
About the view. reference links.
THE TOOLBAR

New View Link
To add a view link to a view

-

g

'

New Note

To create a new note
Although the

toolbar appears
on every view,
Search some buttons
To search the database might not be
available to you
depending on
your user type.

New Movie
To add a movie to a view

New Attachment [&
To add an attachment to a view

View Finder
To find or create a view

(2

Authors

To add, or edit authors and groups.

Show/Hide Palette

To show or hide the drawing palette.
Assessment Tools

Available if tools have been added
Logout

To exit Knowledge Forum

Workspace
To access your Workspace

Scaffolds
To view, add, or edit scaffolds

Help .
To get online help

-

ﬁE
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CREATING A NOTE

1. Click - The New Note window appears. 3. In the File menu, select Save. You will be
prompted for a title for the note and you can

2. Complete the basic note features. You do not need ot - . !
select the view in which this note will appear.

to use every feature when creating a note. The

basic note features consist of the note contents, The note icon will be added to the view and the note
problem, scaffolds, and keywords. window will remain open.

Click to access Shows authors and allows Shows connections to Type the

pull-down menus. you to add co-authors. other notes and views. problem.

B OO\ = New Note - Eric C. s

Bl

File Edit Style Objects Publ\sh Windows
—— = —— % 7 7 —
Add scaffold ———— NC AutNors | Connectio® | Info | Hi)tﬁy — — Type
SUDDOFS: | = —— . content.
ppons: | ¥ Theory Building | Problem e | ~ Arrange
* Selecta — = _ ~ movies,
scaffold from || e attachments,
the Scaffolds | | (Ineed tounderstand " notes, and
drop-down list. | | (_ New information _ views by
Select a | (Thisﬁwc&nnmupl&in_ - - dragging
scaffold | (A better theory Z?Spping
support b_y . [ Putting our knowledge tog | '
double-clicking| | = n e
the support, or | | rE—Ss——— YT ) Keywords
click the — . -1 |
Add button. __m : : Insert Drawing ]I Build-on J(Anm}tate . Close f
—— P
Use keywofd tool to Type in keywords.
select keywords in
note contents. Click to insert  After the note has Click to create
drawing in note. been saved this will an annotation.

highlight. Click to
create a build-on note.

ATTACHMENTS AND MOVIES

The easiest way to add movies and attachments (other documents or images) is to drag them from
your desktop to a Knowledge Forum view or note. An image (jpg, png, or gif) can be displayed as an
image by using the Objects pull-down list on the note or view and selecting Show in Place.

i
or buttons on the toolbar.

To move an existing attachment or movie to a different view or note:
1. Use copy and paste from the File menu to copy the attachment and paste it in the new view or note.

You can also add an attachment or movie using the L

or
2. Drag and drop an attachment or movie icon from a view or note into the content field of your note.
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CONNECTING IDEAS

Referencing

A Whole Note

Drag and drop the note icon to reference into the content of the referencing note.

A Part of a Note (Quoting)

Open the referenced note and copy the text you wish to quote, then paste into the content of the
referencing note.

A View

Drag and drop the view icon to reference into the content of the referencing note.

A Web Page

Type the Web link in http:// format in the content of the note.

Build-On

Open a saved note and click the | Build-on | button on the bottom of the note. shape of the wing

hard R.

A build-on note will open. Add your ideas. When you save the build-on note,
it will be connected to the note it was built on.

Owval shaped
Co-Authors Hector H.
If you are an author of a note, click the - Authors | tab on the top of the note. Add or remove authors to
this note.
Annotate

) O Annotation
Open a saved note and click the 1 Annotate l button on the bottom of the note. % —

An Annotation window will open. Type in your annotation. When you close and

save it an Annotation icon followed by the name of the author will appear in
the note. y

Rise-Above
From a view, select the notes you want to rise above (including notes from other users) and select
Rise-Above from the Objects pull-down list. A rise-above folder g will appear in the note containing the
notes that were selected. Complete the creation of the new Rise-Above note.

WORKSPACE

Your Workspace is a private space where you can create and edit notes, work on a drawings, add
attachments or movies that are only accessible by you. When you are done working on your ideas, you can
add them to a view to make them accessible to the community by dragging and dropping them from your
workspace to a view.

The Palette button shows and hides the drawing palette. Use this
palette to create a drawing in a view or a note.

You can also drag and drop a jpg, png, or gif from your desktop to a I r || T || rd || / || - || - |

view or note, then use the Object pull-down list to Show in Place.
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fu===T THE VIEW FINDER

e View Finder
it Objects Layout Windows

1. From a view, click ﬁ to access the View Finder.
2. Type in the name of the view you want to find or

) Title @ Date Modified C Date Creat
click =

3. Drag and drop from the View Finder to a view to
create a view link.

Creating a New View

1. In the View Finder, go to the File pull-down list and select New View.

CREATING A VIEW LINK

To create a view link in a view:
* Drag a view icon from the View Finder to a view or from a view to a note.

or

1. Click L
2. Select the view to link to from the Choose a view drop-down list.

. The New View Link window appears.

SEARCH

Search for objects by words, author, title, keyword, date modified or date created.

To perform a search:
- = - Search

1. Check or uncheck the Notes, Views, File Edit Objects Layout Windows
Attachments, Movies and Drawings 3 ‘
check boxes to indicate the

Knowledge Forum objects to search for.

ontains  carl

2. Select the criterion from the Search Title () Date Modified () Date Created

d rOp'dOWn list. How many are happy?
Carl B. [Feb 26,2001-Feb 27,2001]

3. Type the search term in the text field. [row many are happy?
Carl B. [Feb 26,2001-Feb 27,2001]
. M bout Qui
4. Click Search. c‘:,r'llsfl [f):lc 1, :;!;S—Feh 16,2001]
ion?

‘é."r'.’aﬂ'}"c [Dec 2, 1999-Aug 31,2000]
EQunling other Authors

Carl B. [Jun 8, 2002-Jun 8,2002]

‘Quoting other Authors

Carl B. [Feb 17.2001-Oct 7.20021
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To log on to Knowledge Forum:

1. Type your Knowledge Forum URL address in http://yourmachinename:port#/
format in your browser. The “Welcome to Knowledge Forum” window appears.
. Select a language from the Language drop-down list.
. Select a database from the Database drop-down list.

2

3
e A 4. Choose the Ul Mode, Basic, to match this Quick Reference section.
5
6

ErkieLxmas
|
o b ookl Al

. Type your username in the Username field.
. Type your password in the Password field.
7. Click Sign On.

Knowledge Forum opens to a view.

W Foroard i sia 22T
hrmby

View: demo: Science: Flight of Airplanes
[l ntep: feric. motion.com:B1 fview?DB=demo&ViewlD=2035

iew Headings
Highlight and
organize selected
objects.

Select option for
displaying notes in
the view.

View Title

The Problem to Solve edit»
View Link — [ The problem: Why do Airplanes Fly?

Click to go to view.

Toolbar Ll (& shape of the wing edit by Richard R. [2000, Aug 31]
| Oval shaped edit by Hector H. [2000, Aug 311 .
See below. Ty Need picture edit by Pablo P. [2002, Apr 26] - The Do Action drOp'
picture of airplane edit by Hector H. [2002, Oct 04] H
Air pressure pushes edit by TC T. [2000, Aug 31] dOWn IISt al IOWS yOU tO
Note Tl More info edit by My M. 12000, Aug 311 move or clear selected
f u [3 Hard 10 explain edit by TC T. [2000, Aug 31] 3
CIICk tO read nOte' [ Jow pressure and high pressure edit by EricC E. [2002, Jan 21] Ob]eCtS, and Create
I Wind is a factor edit by Bereiter C. [2000, Aug 31] headings
[E]
H A [H The higher y()ug edit by Kit K. Jan 2 .
CI' k q uestion? edii by Bereiter
Picture &
ick to open: [H Experiment #2 edit by Mary M. [2002, Oct 07]
p [} Higher means lower pressure edit by EricC E. [2002, Oct 07]
[H Good question edis by Mary M. [2002. Jan 21] Add To Reader
Attachment [H Aunosphere is a factor edit by Al 000, Aug 311
HSuni Clear Selected
: P un influences edit by Alan A. [2000, Aug 311
Click to open. s Delete Selected
B hang glide edis by Marge €. [2004,Jan 21] 2
{2 airplane edir by Marge C. [2004,Jan 21] New Rise-Above Note

+ Do Action...

Movie Eﬁu edit by Marge €. 12004, Jan 21] New Reference Note
C||Ck tO Open ) About airplane construction edit by Marge C. [2007, Sep 13] New Heading
! = About flight mov_edis by Marge C_{2007. Sep 13] : Copy To View... »
THE TOOLBAR ——
New Note New View Link
To create a new note To add a view link to a view
New Attachment New Movie
To add an attachment to a view To add a movie to a view Although the
. . toolbar appears
View List Search PP

on every view,

To search the database SO L ERS

To find or create a view

Workspace/Reader = Authors might not be
To access your Workspace | [ To view, add, or edit authors, available to you
Scaffolds groups, and registration codes depending on

To view, add, or edit scaffolds your user type.

Available if tools have been added

Help . W Logout
To get online help To exit Knowledge Forum

I !I Assessment Tools
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CREATING A NOTE

/
1. Click . The New Note window appears.

2. Complete the basic note features. You do not need
to use every feature when creating a note. The
basic note features consist of the Title, In View,
Scaffold, Content, Reference, Keywords, and
Problem sections.

3. Click Advanced to access the advanced note
features. You do not need to use the advanced
features to create a note. In advanced mode,
you can add co-authors, hide or display image
attachments, and nominate a note for publication.

4. Click Close and Contribute.

The note appears in read mode as it is added to
the view.

Click to access the advanced note features. Click to save the note and close the window.

New Note

Type the note’s title. | Close and Contribute | | Cancel

| Welcome To Knowledge Forum <€

< Type content.

! Advanced

Select the view to
add the note to.

Add scaffold supports:

* Select a scaffold
from the Scaffolds
drop-down list.

Theory Building >

My theory

I need to understand
New information
This theory cannot explain

A better theory

Putting our knowledge together

* Select a scaffold
support from the
Scaffold list box.

* Click Add.
* Type the scaffold

|_—Select a note,
view, attachment,
or movie to
reference from
the corresponding

s:DFéort text ifn Id Attachment ! I:]K:::e = = (Fj‘eferel_nfe e
the Content fie eferenc
between the >

< symbols of the AN

scaffold support’s Problem

HTML code. \

= - or

Type the keywords. Type the problem.

<kf:support support="New information" ID="18"=Enter text
here.</kf:support>

REFERENCING

Whole Note Web Page

Select the note to reference from the Note drop-down
list in the Reference section of the referencing note.

Part of a Note (Quoting)

Open the referenced note and copy and paste the
text you wish to quote between the > < symbols in
the Content field of the referencing note.

View
Select the view to reference from the View drop-down
list in the Reference section of the referencing note.

Type the Web link in http:// format in the Content field
of the note.

Movie Segment

Open the movie. Set the start and end points of the
movie segment and click Produce Movie Segment.
Copy the movie segment’s HTML code into the
Content field of the referencing note.

HTML code for each reference will be added to the
Content field of your note.
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CONNECTING IDEAS

In addition to referencing, you can connect ideas in
Knowledge Forum using several different methods.

Rise-Above Note

From a view, check the notes you want to rise above
(including notes from other users) and select New
Rise-Above from the Do Action drop-down list.
Complete the creation of the new rise-above note.

Build-On Note
In read mode, click Build-on in the note you want to
build on. Complete the creation of the build-on note.

ATTACHMENTS

To add an attachment to a view:
1. Click =54, The New Attachment
window appears.
2. Type the title in the Title field.

3. Click Choose File. The Open
window appears.

4. Select the file to attach.
5. Click Choose.

6. In the New Attachment window, select the
view to add the attachment to.

7. Click Close and Contribute.
To add a new attachment to a note:

1. Select Create new attachment from the
Attachment drop-down list in the Reference
section. The New Attachment window
appears.

2. Complete the New Attachment window.
3. Click Close and Contribute to save the note.

Create new attachment
Knowledge Building Features:
Knowledge Building
The Evolution of Knowledge Forum
My Attachments:
Knowledge Forum Workshops
MNew Knowledge Building ideas
Adding a Note

Attachment drop-down list

To add an existing attachment to a note:

1. Select an attachment from the Attachment
drop-down list in the Reference section.

2. Click Close and Contribute.

Co-Authors
In advanced mode, add or remove authors from the
Authors section of the note.

Publish
In advanced mode, click the Candidate for
Publication check box.

Annotate
In read mode, click Annotate and type your annotation
in the Annotation field of the New Annotation window.

To add a movie to a view:

1. Click 4®  The New Movie window appears.

2. Type the e
title in the
Title fiold. [DEE
3. Click = e
Choose © Streaming
File next

to the File field. The Open window appears.
4. Select the movie file to attach.
5. Click Choose.

6. In the New Movie window, select the view to
add the movie to.

7. Select the playback option.
8. If you want to add a poster frame:

Click Choose File next to the Poster frame.
The Open window appears.

Select a .jpg file to associate with the
movie. Click Choose.

9. In the New Movie window, click Close
and Contribute.

To add a new movie to a note:

1. Select Create new movie from the Movie
drop-down list in the Reference section. The
New Movie window appears.

2. Complete the New Movie window.
3. Click Close and Contribute to save the note.
To add an existing movie to a note:

1. Select a movie from the Movie drop-down
list in the Reference section.

2. Click Close and Contribute.
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-'_ﬂ CREATING A VIEW LINK
-

To create a view link in a view: 1. Click . The New View Link window appears.

2. Select the view to link to from the Choose a view drop-down list.

From a view, click to access the View List window.

Copy selected view links to My Hotlist or other views by using the Do Action drop-down list.

View List for KForumDemo4_6 Select the type of views

Click the check - to display from the Show
box to select View List: Level | Views  Show [EYIENEmED | "=~V pey

drop-down list.

the view link.

=

Click the view Click to create a new view.
link to access

the view.

(W = Headings View 2
B K-12 Scenarios m

= =] Knowledge Building Features

SEARCHING

Search for objects by text in the object body, author, keyword, note title, view title, problem, scaffold support,
user group, date created, date last modified, unread, references to your notes, and, for editors and managers,
status and accessibility. The initial criterion chosen will determine the remaining Search fields available.

To perform a search:

1 . Check or uncheck the Notes, Views, Attachments, and Movies check boxes to indicate the Knowledge
Forum objects to search for.

2. Select the initial criterion from the first Search drop-down list.
3. Select from the second Search drop-down list (if applicable).

4. Either type the search term in the text field or select from the third drop-down list (if applicable).

5.Click Find. ene Search KForumDemo4_6
Search and Notification
Saved searcheS\ My Searches My Notifications
listed for future use. B4 Author contains "alan"  delete (1 Author contains "alan” edit delete
create another natification Set notification in
[2]_Unread by Self and Title contains % Unread by Self and Title contains order to receive
“search" delete "search” edit delete . .
create another notification e-mall Wlth updated

= R 7
Search for ™ Notes & Views # Attachments # Movies where

Increase the

number Of . Author %) [contains [§) alan
search criteria to
narrow the search. [ Find |
Search Title [Author contains “alan”
Save search criteria.
5
—
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